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About this document
This chapter includes the following topics:

■ About this technical note

■ About troubleshooting Enterprise Vault Reporting

About this technical note
This technical note describes how to troubleshoot problems with the Enterprise
Vault Reporting feature that is supplied with Enterprise Vault 11.0.

To troubleshoot other versions of Enterprise Vault Reporting, see the appropriate
issue of this technical note.

For information on troubleshooting FSA Reporting, see the following technical note
on the Veritas Support website: http://www.veritas.com/docs/000088358.

About troubleshooting Enterprise Vault Reporting
See the appropriate section of this technical note for help with the following:

See “About Setting up SQL Server Reporting
Services” on page 8.

Problems with setting up Microsoft SQL
Server Reporting Services or assigning the
Content Manager role to the Vault Service
account.

See “About troubleshooting configuration and
report deployment” on page 10.

Problems when deploying Enterprise Vault
Reporting's reports.

See “About troubleshooting accessing the
reports” on page 23.

Problems with accessing reports that were
deployed successfully.
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See “About troubleshooting using and
exporting the reports” on page 30.

Problems with the content of some reports,
or with exporting the reports to different
formats.

Note: From Enterprise Vault 10.0.3, you can limit the Vault Service account’s SQL
privileges to increase database security. The Enterprise Vault databases contain
a set of roles that enable you to assign to the Vault Service account only those SQL
privileges that are required to run Enterprise Vault. However, if you limit the SQL
privileges of the Vault Service account for normal daily operations, you may need
to grant additional SQL privileges to the account for other tasks that require higher
privileges.

For more information on using the SQL Server roles, see the following article on
the Veritas Support website: http://www.veritas.com/docs/000070503.
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Setting up SQL Server
Reporting Services

This chapter includes the following topics:

■ About Setting up SQL Server Reporting Services

■ Help with setting up SQL Server 2008 R2 Reporting Services

■ Help with setting up SQL Server 2012 Reporting Services

About Setting up SQL Server Reporting Services
You must install Enterprise Vault Reporting on a computer on which Microsoft SQL
Server Reporting Services is installed.

For details of the supported versions of SQL Server and SQL Server Reporting
Services, see the Enterprise Vault Compatibility Charts on the Veritas Support
website at http://www.veritas.com/docs/000097605.

As part of preparing for the installation of Enterprise Vault Reporting, you must
assign the SQL Server Reporting Services Content Manager role to the Vault Service
account.

If you have problems with setting up SQL Server Reporting Services or assigning
the Content Manager role, refer to the following:

■ See “Help with setting up SQL Server 2008 R2 Reporting Services” on page 9.

■ See “Help with setting up SQL Server 2012 Reporting Services” on page 9.
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Help with setting up SQL Server 2008 R2
Reporting Services

If you have problems with the setting up of Microsoft SQL Server 2008 R2 Reporting
Services, the following Microsoft articles may be of assistance:

■ Installing and configuring SQL Server 2008 R2 Reporting Services:
https://msdn.microsoft.com/library/ms143736.aspx

■ About Report Manager:
https://msdn.microsoft.com/library/ms157147.aspx

■ Assigning the Content Manager role to the Vault Service account:
https://msdn.microsoft.com/library/aa337471.aspx

Help with setting up SQL Server 2012 Reporting
Services

If you have problems with the setting up of Microsoft SQL Server 2012 Reporting
Services, consult your Microsoft documentation.
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Troubleshooting
configuration and report
deployment

This chapter includes the following topics:

■ About troubleshooting configuration and report deployment

■ About using DTrace with Microsoft SQL Server Reporting Services

■ Identifying the problem

■ Configuring Reporting and deploying the reports

About troubleshooting configuration and report
deployment

Follow the information in this chapter if the Reporting Configuration utility indicates
that there was a problem during either of the following:

■ The configuration of the Enterprise Vault Reporting feature

■ A subsequent re-deployment of the Enterprise Vault reports
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About using DTrace with Microsoft SQL Server
Reporting Services

Do not attempt to run the Enterprise Vault debug utility DTrace on the Reporting
Services Report Manager process, Reporting ServicesService.exe. Report
Manager does not render the reports correctly if you enable DTrace on it.

You can use the Microsoft utility DebugView in place of DTrace in this instance.
You can obtain DebugView from the following location:

https://technet.microsoft.com/sysinternals/bb896647.aspx

Identifying the problem
To identify the problem

1 Note down any message that is displayed during the configuration.

2 Examine the Reporting deployment log file EVDeployReports.Log for any error
indications. The log file is in the EVReports subfolder of the Enterprise Vault
installation folder.

3 Follow the appropriate instructions below to resolve the problem.

“Reporting Configuration Utility is unable to copy file...” message
Symptoms: The Reporting Configuration utility displays a message similar to the
following:

Reporting Configuration Utility is unable to copy file

"source_file_path"

To "destination_file_path"

Please copy file manually after configuration ends.

Cause: Enterprise Vault was unable to copy a file such as EVRT.dll to the required
location during the configuration. The problem is usually because the file is locked.

Resolution:When the configuration has finished, copy the indicated file to the
specified destination location.

If you cannot copy the file because it is still locked, use the MMC Services snap-in
to restart the SQL Server Reporting Services service, and then try again

11Troubleshooting configuration and report deployment
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“Reporting has been configured on this machine. However, there
were a few warnings and/or errors...” message

Symptoms: The Reporting Configuration utility displays the following message:

Reporting has been configured on this machine. However, there were

a few warnings and/or errors, as a result of which some reports may

not work. For details, see the log file EVDeployReports.Log in the

EVReports subfolder of the Enterprise Vault installation folder.

Cause: The configuration was successful, but Enterprise Vault noted one or more
of the following conditions:

■ Enterprise Vault auditing is not configured.

■ FSA Reporting is not configured.

To determine the cause of the message, examine EVDeployReports.Log.

Resolution: Some of Enterprise Vault Reporting’s reports require one of the
following:

■ Enterprise Vault auditing. See “About Enterprise Vault auditing” on page 12.

■ FSA Reporting. See “About FSA Reporting” on page 12.

About Enterprise Vault auditing
The following Enterprise Vault Reporting Operation reports require auditing to be
configured on the Enterprise Vault server:

■ Archived Items Access

■ Archived Items Access Trends

If you intend to run either of these reports, you must configure auditing.

You must enable auditing to create the auditing database, and then configure the
auditing level for the required auditing categories in the properties of the Enterprise
Vault server.

For more information on how to enable and configure auditing for Enterprise Vault,
see the Administrator’s Guide.

About FSA Reporting
If you intend to run Enterprise Vault Reporting’s Data Analysis reports you must
configure FSA Reporting.

The Data Analysis reports do not show data for a file server or a volume until FSA
Reporting has performed a successful scan on that file server or volume.
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For information on configuring FSAReporting and running a scan, see theReporting
guide.

“Authentication failed for reporting user” error message
Symptoms: The Reporting Configuration utility displays a Validation Error or Error
in Prerequisites dialog with the message:

Authentication failed for reporting user

Cause: There is a problem with the Reporting user account credentials you entered.

Resolution: To resolve this problem:

1 Ensure you are supplying the correct user name and password for the Reporting
user account.

2 Ensure you can ping the domain specified in the credentials.

3 Rerun the Reporting Configuration utility with the Configure Reporting and
deploy or upgrade reports option. When specifying the domain, try providing
a fully qualified domain name (FQDN).

See “Configuring Reporting and deploying the reports” on page 22.

“The specified SQL Server does not exist” error message
Symptoms: The Reporting Configuration utility displays the following error message:

The Specified SQLServer does not exist.

Cause: This message appears if you enter an invalid SQL Server name.

Resolution:Rerun the Reporting Configuration utility with theConfigure Reporting
and deploy or upgrade reports option. Enter the correct name for the SQL Server.

See “Configuring Reporting and deploying the reports” on page 22.

“Ensure that you can browse to the Report Manager...” error message
Symptoms: The Reporting Configuration utility displays the following error message:

Ensure that you can browse to the Report Manager Web application and

view its Home page successfully. The URL has the format

http://host_name/webapp_name/, for example

http://myserver.mydomain.com/Reports/. When you have displayed the

Report Manager Home page, click ‘OK’ below to continue.
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Cause: This message appears if the Configuration utility is unable to access the
Microsoft Reporting Services Report Manager web application.

Resolution: Make sure that the Microsoft SQL Server Reporting Services are
configured and running.

Then follow the error dialog instructions to browse to the Report Manager web
application’s home page.When you have successfully accessed the web application
home page, click OK on the error dialog to continue the configuration.

If the same error dialog reappears when you click OK, refresh the Report Manager
home page and then click OK on the dialog again. On a slow Report Server you
may need to repeat these actions a number of times until the error dialog no longer
appears and the reports deploy successfully.

“EnterpriseVaultDirectory database does not exist...” error message
Symptoms: The Reporting Configuration utility displays the following error message:

‘EnterpriseVaultDirectory’ database does not exist on the specified

SQL server.

Cause: This message appears if the Configuration utility fails to detect the Enterprise
Vault Directory database on the specified SQL Server.

Resolution:Rerun the Reporting Configuration utility with theConfigure Reporting
and deploy or upgrade reports option. Enter the name for the SQL Server that
contains the Enterprise Vault Directory database.

See “Configuring Reporting and deploying the reports” on page 22.

“Failed to connect to the specified SQL Server with the credentials
you provided” error message

Symptoms: The Reporting Configuration utility displays the following error message:

Failed to connect to the specified SQL Server with the credentials

you provided.

Cause: This message appears if the utility is unable to connect to the SQL Server
with the credentials of the account that you are logged in with.

Resolution: Make sure that the Vault Service account that you are using can
connect from the Reporting Services computer to the SQL Server that you specified.
Then rerun the Reporting Configuration utility with the Configure Reporting and
deploy or upgrade reports option.

See “Configuring Reporting and deploying the reports” on page 22.
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“Failed to deploy reports on the report server” error message
Symptoms: The Reporting Configuration utility displays an error message similar
to the following:

Failed to deploy reports on the report server. Please refer to the

EVDeployreports.log file and to the ‘Troubleshooting

Enterprise Vault Reporting’ article for more details.

Note: If you get this message, run the Enterprise Vault reports that you intend to
use. If the reports contain data, then you can ignore the message.

Remember that if you have configured FSA Reporting, the Data Analysis reports
do not show data for a file server or a volume until FSA Reporting has performed
a successful scan on that file server or volume.

Cause: One of the following problems may have occurred during the report
deployment:

■ A SQLException occurred when the Reporting Configuration utility attempted
to do any of the following:

■ Add the Reporting user account to the Enterprise Vault databases.

■ Create the role EVReportingRole on the auditing database.

■ Grant ‘SELECT’ access permissions to the EVReportingRole.

■ The Reporting Configuration utility was unable to set access for the Reporting
user on the Report Server’s bin folder.

Resolution: If you run all the Enterprise Vault reports you intend to use and they
contain data, you can ignore the message that the reports failed to deploy
successfully.

If any of the reports do not contain data, work through the following steps:

1 A likely reason for the ‘Reports failed to deploy successfully’ message is the
absence of an auditing database or an FSA Reporting database. These
databases are required for some of Enterprise Vault Reporting’s reports:

■ The auditing database is required for two of the Operation reports, Archived
Items Access and Archived Items Access Trends. If the auditing database
is absent, you will see entries similar to the following in
EVDeployReports.Log:

EnterpriseVaultAuditDb is not configured
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Database: EnterpriseVaultAudit, SQL Server: MyServer

Error connecting

Note: If you do not want to use the archived items access reports, you can
ignore these log entries.

If you want to use the Archived Items Access and Archived Items Access
Trends reports, you must enable Enterprise Vault auditing.
For information on enabling Enterprise Vault auditing, see theAdministrator’s
Guide.

■ An FSA Reporting database is required for all the Data Analysis reports. If
the FSAReporting database is absent, entries similar to the following appear
in EVDeployReports.Log:

EnterpriseVaultFSAReportingDb is not configured

Database: EnterpriseVaultFSAReporting, SQL Server: MyServer

Error connecting

Note: If you do not want to use the Data Analysis reports, you can ignore
these log entries.

If EVDeployReports.Log indicates another problem, work through the rest of
the steps below. You can ignore some of the entries in the log.

See “Identifying the problem” on page 11.

2 Ensure that a SQL Server login for the Reporting user account is present on
the SQL servers used for the Enterprise Vault Directory database, all Vault
store databases, and the Enterprise Vault Monitoring database.

3 Ensure that the EVReportingRole role has been assigned to the Reporting
user SQL Server login on all Enterprise Vault databases.
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4 Ensure that, for each database listed in the following table, the EVReportingRole
role has been granted SELECT access permission for the specified views.

ViewDatabase

EVAuditViewEnterpriseVaultAudit

ArchiveViewEnterpriseVaultDirectory

ComputerServiceTypeView

VaultEntryView

view_ComputerEntry

view_ComputerTask

view_DominoMailboxArchivingStatus

view_ExchangeMailboxArchivingStatus

view_ExchangeMailbox_Server

view_ExchangeServerEntry

view_MonitoringSettings

view_NotesJournal_Server_Domain

view_NotesMailServerEntry

view_NotesMailServer_Domain

view_NotesMailboxArchivingStatus

view_PartitionEntry

view_PolicyTargetGroup_PolicyEntry

view_ReportSettings

view_Root

view_Site

view_Storage_VaultStoreEntry

view_Trustee

JrnMailBoxParametersViewEnterpriseVaultMonitoring

MailboxParameterConfigView
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ViewDatabase

view_DominoJrnMailBoxParameters

view_MailboxMonitoringHistory

view_ServiceMonitoringHistory

view_TaskMonitoringHistory

view_CollectionVault Store database(s)

view_ListVaults

view_SaveSet

view_Saveset_Archive_Vault

view_Saveset_Propertie

view_VaultStoreSummary

5 Ensure that the Reporting user has been granted “log on locally” rights on the
Reporting Services Report Server computer.

6 Ensure the Reporting user has full control access rights on the folder
<Reporting_Services_install_folder>/ReportServer/bin.

7 Try to access the reports. If you continue to have problems you may have to
troubleshoot.

See “About troubleshooting accessing the reports” on page 23.

See “About troubleshooting using and exporting the reports” on page 30.

Error code 1 and log file error “System Net.Web Exception: Page
cannot be found”

Symptoms: The Reporting Configuration utility displays an error message with
error code 1 and the message:

Error: Report Deployment Failed. Miscellaneous error.

In addition, the following error message appears in EVDeployReports.Log:

System Net.Web Exception: The request failed with HTTP status 404:

Page cannot be found

Cause: Enterprise Vault could not access the Report Server to deploy the reports,
due to firewall or trusted site settings.
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Resolution:

1 On the Report Server computer, open Internet Explorer, select Tools > Internet
Options, and select the Connections tab.

2 Click LAN Settings and, in the Proxy server area, clear the Use a Proxy
Server for LAN check box.

3 Click OK and then click OK again to exit the dialogs.

4 Again from Internet Explorer select Tools > Internet Options and select the
Security tab.

5 Select the Local intranet web content zone. Then, in the Local intranet area,
click Sites to display the Local intranet dialog.

6 Click the Advanced button and add the URL for the Report Server to the list
of websites in this zone. The Report Server URL is as follows:

http://<host_name>/<report_server_name>/

Where:

<host_name> is the fully qualified host name of the computer hosting the
Microsoft SQL Server Reporting Services Report Server.

<report_server_name> is the name of the Report Server.

For example:

http://myserver.evdomain.com/ReportServer

or:

http://myserver.evdomain.com/ReportServer$MyInstance

where MyInstance is the Reporting Services instance name. You can obtain
this URL from the RSReportServer.config file. This file is present in the parent
folder of the bin folder where the reports are to be installed. Typically this path
is as follows:

SQL_Server_install_path\SQL_reporting_install_folder\ Reporting

Services\ReportServer

For example:

C:\Program Files\Microsoft SQL Server\MSSQL.2\Reporting

Services\ReportServer
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7 Click Close orOK and thenOK to close the Local intranet dialogs. Then click
OK to exit the Internet Options dialog.

8 Rerun the Reporting Configuration utility with the Configure Reporting and
deploy or upgrade reports option.

See “Configuring Reporting and deploying the reports” on page 22.

Log file error “Assembly security permission grant set”
Symptoms: The Reporting Configuration utility displays the error message:

Error: Report Deployment Failed

and EVDeployReports.Log contains the following error message:

Assembly AssemblyName security permission grant set is

incompatible between app domains

Cause: This problem is described in detail in the Microsoft Knowledge Base article
http://support.microsoft.com/?kbid=822526&FR=1.

Resolution: To resolve this problem:

1 Restart the IIS Admin service.

2 Rerun the Reporting Configuration utility with the Configure Reporting and
deploy or upgrade reports option. .

See “Configuring Reporting and deploying the reports” on page 22.

“Couldn’t disable MyReports” error
Symptoms: The Reporting Configuration utility displays a dialog with the following
message:

Couldn't disable MyReports. Please disable My Reports in

SiteSettings of Report Manager and Click OK. Please see help for

details.

Cause: The problem may occur if you have selected the following Microsoft SQL
Server Reporting Services setting to create a “My Reports” folder for each user:

Enable My Reports to support user-owned folders for publishing and

running personalized reports

This setting appears on the Reporting Services Report Manager’s Site Settings
page:
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Figure 3-1 Report Manager Site Settings page

Enterprise Vault normally clears the setting temporarily while it deploys the reports.
However, if you receive this error, Enterprise Vault has been unable to clear the
setting.

Resolution: Clear the Enable My Reports setting on the Site Settings page
temporarily while you deploy the reports, as follows:

1 In Internet Explorer, enter the URL for the SQL Server Reporting Services
Report Manager web application. The URL has the following format:

http://host_name/reportmgr_Webapp_name/

Where:

■ host_name is the fully qualified host name of the computer hosting the
Microsoft SQL Server Reporting Services Report Manager web application.

■ reportmgr_Webapp_name is the name of theMicrosoft SQL Server Reporting
Services Report Manager web application.
For example:
http://myserver.evdomain.com/Reports/

2 On the Report Manager Home page, click Site Settings.

3 On the Site Settings page, clear Enable My Reports, and clickApply to save
the change.
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4 Run the Enterprise Vault Reporting Configuration utility to deploy the Enterprise
Vault reports.

See “Configuring Reporting and deploying the reports” on page 22.

5 Restore theEnableMy Reports setting on the Report Manager’s Site Settings
page and click Apply to save the change.

Configuring Reporting and deploying the reports
You can configure Enterprise Vault Reporting and deploy its reports using the
Enterprise Vault Reporting Configuration utility. If the configuration fails for some
reason, you can rectify the error and then re-run the Reporting Configuration utility
with the Configure Reporting and deploy or upgrade reports option.

To configure Reporting and deploy reports

1 Start the Enterprise Vault Reports Configuration utility.

2 On the Reporting Configuration utility dialog box:

■ Select Configure Reporting and deploy or upgrade reports.

■ Enter the Domain, User name and Password for the Reporting user
account.

■ Re-enter the SQL Reporting Services Instance.

■ Specify the Language in which to deploy the reports.

■ Specify the name of the Directory database SQL Server.

3 Click Configure to deploy the reports.
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Troubleshooting accessing
the reports

This chapter includes the following topics:

■ About troubleshooting accessing the reports

■ Unable to view the reports

■ Report Server web page does not show the Enterprise Vault folder

■ Role assignments and changes fail to get implemented

■ Error message "An error has occurred during report processing" with SQL Server
2008 R2 Reporting Services

■ Unable to access Enterprise Vault reports from a different domain

■ Unable to access Report Manager on a 64-bit Windows system due to a
permissions issue

■ Changing the Reporting user account details

About troubleshooting accessing the reports
This chapter describes how to troubleshoot problems with accessing Enterprise
Vault Reporting’s reports.

Note: This chapter assumes you have successfully deployed Enterprise Vault
Reporting’s reports.
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Unable to view the reports
If you experience general problems with logging in or getting reports to display
successfully, follow this checklist:

■ If you can access the Report Server web page, but you cannot see the Veritas
Enterprise Vault folder, this may be due to the user account not belonging to
the correct SSRS role.
See “Report Server web page does not show the Enterprise Vault folder”
on page 25.

■ Make sure that you access the SQL Server Reporting Services Report Manager
web application with an account that is assigned to a suitable Enterprise Vault
administrator role:

■ See "About accessing Enterprise Vault Reporting's reports" in the Reporting
guide.

■ See “Role assignments and changes fail to get implemented” on page 25.

■ Confirm that the prerequisites for Enterprise Vault Reporting are satisfied. See
the following:

■ The section "Prerequisites for Enterprise Vault Reporting" in the Reporting
guide.

■ The Enterprise Vault Compatibility Charts on the Veritas Support website at
http://www.veritas.com/docs/000097605.

■ Make sure that you have a working network connection to the computer or
computers hosting the Enterprise Vault databases.

■ Verify that IIS is not locked down, and that IIS services are not stopped. Try
stopping and restarting IIS.

■ Ensure that a SQL Server login for the Reporting user account you created in
the preinstallation steps is present on all the SQL servers used for the Enterprise
Vault Directory database, all vault store databases, and the Monitoring database.

■ Ensure that the EVReportingRole role has been assigned to the Reporting user
SQL Server login on all Enterprise Vault databases.

■ Ensure that the EVReportingRole role has been granted “SELECT” access
permission for the specified views for each database.
See ““Failed to deploy reports on the report server” error message” on page 15.

■ Check whether the Reporting user account password has expired. Ideally this
password should have been set never to expire, as described in the Reporting
guide. If the account password has expired, you must change the Reporting
user account credentials.
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See “Changing the Reporting user account details” on page 27.

Report Server web page does not show the
Enterprise Vault folder

Problem: The Veritas Enterprise Vault folder is not visible on the SQL Server
Reporting Services Report Server web page.

Cause: The user account may not belong to the correct SSRS role.

Resolution: Do as follows:

1 Clear your Internet Explorer browser cache.

2 Log in again to the SQL Server Reporting Services Report Server.

3 Click the Properties tab and on the Security page make sure that the user
account is added to the SQL Server Reporting Services Enterprise Vault
Browser role.

Role assignments and changes fail to get
implemented

Problem: You make changes to the Enterprise Vault roles-based security from
Authorization Manager in the Administration Console, but these changes do not
get implemented.

Cause: This problem may be due to caching latency. If you add, remove or change
roles from Authorization Manager and then save your changes, there is a latency
of about one minute before you can successfully make further changes.

Resolution: After applying changes to roles in Authorization Manager, wait at least
one minute for the changes to take effect, before you start Authorization Manager
again to make further role assignments or changes.

See the procedures for assigning, modifying, and creating roles underRoles-based
administration in the Administrator’s Guide.

Note that you must also enable the synchronization of Enterprise Vault Reporting
roles-based security.

See “Enabling the synchronization of Enterprise Vault Reporting roles-based
security” in the Reporting guide.
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Error message "An error has occurred during
report processing" with SQL Server 2008 R2
Reporting Services

Problem:When SQL Server 2008 R2 Reporting Services Report Manager renders
a report it displays the following message:

An error has occurred during report processing.

(rsProcessingAborted) The Value expression for the query parameter

â€˜@SearchResultâ€™ contains an error: Index was outside the

bounds of the array. (rsRuntimeErrorInExpression)

Cause: This error message appears if there is no data available to display for the
report. This is a known issue with Microsoft SQL Server 2008 R2 Reporting Services.
The issue is described on the following Microsoft Connect page:

http://connect.microsoft.com/SQLServer/feedback/ViewFeedback.aspx?Feedba
ckID=416371

Resolution:Wait until Enterprise Vault Reporting has completed a successful data
scan and then re-run the report.

Ensure that Enterprise Vault is gathering data for the report. Note that FSAReporting
does not gather data by default for the duplicate files reports. For more information,
see the Reporting guide.

Unable to access Enterprise Vault reports from a
different domain

Problem: You cannot browse to the Veritas Enterprise Vault folder from the
Report Manager Home page when you access the Report Server from a computer
in a different domain. Internet Explorer repeatedly prompts you for login credentials,
which it does not accept.

Cause: There is an issue with Internet Explorer’s security settings.

Resolution: To resolve this problem, do as follows:

1 In Internet Explorer, select Tools > Internet Options.

2 Click the Advanced tab, and under Security, clear the setting Check for
signatures on downloaded programs.

3 Restart Internet Explorer.
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Unable to access Report Manager on a 64-bit
Windows system due to a permissions issue

Affected configurations: Report Manager running on a 64-bit Windows system.

Problem: After the deployment of Enterprise Vault Reporting’s reports, Report
Manager fails to open. SQL Server Reporting Services displays an Error page which
states that the permissions granted to your user account are insufficient for
performing this operation.

Cause: A possible cause is that the EvAzStore.xml file is not up-to-date.

Resolution: Follow this procedure to check the timestamp of the EvAzStore.xml

file and if necessary, register azroles.dll manually:

1 On the computer on which SQL Server Reporting Services is installed, browse
to the ReportServer\bin folder under Program Files\Microsoft SQL Server.

2 Find the file EvAzStore.xml and examine its Date Modified timestamp.

If the timestamp indicates a date and time that is before the time that you first
attempted to access Report Manager’s home page after deploying the
Enterprise Vault reports, continue with this procedure to register the Microsoft
DLL file azroles.dll manually.

3 Open the Windows Control Panel, select Administrative Tools and then
select Microsoft .NET Framework 2.0 Configuration.

4 In the left pane of the .NET Framework 2.0 Configuration utility, expand My
Computer, right-click Assembly Cache and choose Add.

5 Browse to the following folder: WINDOWS\Microsoft.NET\AuthMan\1.2

6 Select the file microsoft.interop.security.azroles.dll and click Open
to add this assembly.

7 Close the .NET Framework 2.0 Configuration utility.

8 Open the Services snap-in to the Microsoft Management Console, and restart
the IIS Admin Service and the SQL Server Reporting Services.

Changing the Reporting user account details
Enterprise Vault Reporting requires an Active Directory user account to use when
accessing the Enterprise Vault databases. If you want Enterprise Vault Reporting
to use a different user account, or if the existing account password expires, you
can change the credentials of the account in either of the following ways:

■ From the Enterprise Vault Reporting Configuration utility.
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See “To change the Reporting user account credentials using the Reporting
Configuration utility” on page 28.

■ By manually updating the account’s credentials in the shared data source on
the Reporting Services Report Server, and then assigning the required role and
rights to the new account.
See “To change the Reporting user account credentials manually” on page 28.

To change the Reporting user account credentials using the Reporting
Configuration utility

1 If you require a new Windows user account, create the replacement account
in the Active Directory domain. This account does not require a mailbox, and
need not be a member of theWindows Administrators group. When you create
the account:

■ Select the Password Never Expires option.

■ Leave the remaining check boxes clear (User Must Change Password at
Logon, Use Cannot Change Password, Account is Disabled).

2 Start the Enterprise Vault Reports Configuration utility.

3 On the Reporting Configuration utility dialog box:

■ Select Reconfigure data access settings for Reporting.

■ Enter the Domain, User name, and Password for the new or modified
Reporting user account.

■ Re-enter the SQL Reporting Services Instance.

■ Specify the name of the Directory database SQL Server.

■ Click Reconfigure to configure the new Reporting user account.

To change the Reporting user account credentials manually

1 If you require a new Windows user account, create the replacement account
in the Active Directory domain. This account does not require a mailbox, and
need not be a member of theWindows Administrators group. When you create
the account:

■ Select the Password Never Expires option.

■ Leave the remaining check boxes unselected (User Must Change
Password at Logon, Use Cannot Change Password, Account is
Disabled).

2 Go to the Report Manager web application, for example
http://<host_name>/reports.

3 Log in with an account that has a content manager role on the Report Server.
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4 Click the Veritas Enterprise Vault link.

5 Click Show Details.

6 Click the EnterpriseVaultDS link.

7 In Connect using, select Credentials stored securely in the report server.
Then set the new user name and password and click Apply.

8 Close the Report Manager web application.

9 Assign the EVReportingRole role to the new Reporting user on all Enterprise
Vault databases, including the Monitoring database,
EnterpriseVaultMonitoring, and the Auditing database,EnterpriseVaultAudit,
if it has been configured.

10 Grant the log on locally right to the new Reporting user on the Reporting
Services Report Server computer.

11 Ensure that the new Reporting user has full control access rights on the folder
<Reporting_Services_install_folder>/ReportServer/bin.
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Troubleshooting using and
exporting the reports

This chapter includes the following topics:

■ About troubleshooting using and exporting the reports

■ Troubleshooting problems with report content

■ Troubleshooting report export

■ About using Reporting with multiple Reporting Services

About troubleshooting using and exporting the
reports

This chapter describes how to troubleshoot problems with the content and export
of Enterprise Vault Reporting’s reports.

Note: This chapter assumes you have successfully deployed the Enterprise Vault
Reporting reports, and can access them successfully.

Troubleshooting problems with report content
This section describes how to troubleshoot problems that affect the content of the
Enterprise Vault reports.

Note: The problem may be seen in all supported Microsoft Reporting Services
configurations, unless a specific configuration is quoted.
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Images or data fail to appear
Problem: Data and images are omitted from a report when you first run it.

Cause: This problem can occur on the first occasion that you run a report, if the
Microsoft Reporting Services Report Server’s name contains special characters
such as a hyphen or underscore.

Resolution: To work around this problem, run the report and then click theRefresh
button on the Report Manager toolbar (located below the parameter value entry
boxes). The images and data should display correctly in the refreshed screen.

Reports omit data related to some vault stores
Problem: Reports omit data from some vault stores.

Cause: You have not set up the Reporting user account’s access roles correctly.

Resolution: Ensure that the Reporting user account is assigned the
EVReportingRole role on the vault store SQL server.

No information appears in the Data Analysis reports
Problem: The Data Analysis Reports contain no data.

Cause: These reports require Enterprise Vault FSA Reporting to be configured.
FSA Reporting must also have completed a successful scan of the file server or
volume.

Resolution: Configure FSA Reporting from the Enterprise Vault Administration
Console and ensure that FSA Reporting has performed a successful scan. For
instructions, see the Reporting guide.

No information appears in reports that use Monitoring data
Problem: The following Operation Reports contain no data:

■ Domino Server Journal Mailbox Archiving Health

■ Domino Server Journal Mailbox Archiving Trends

■ Enterprise Vault server 24-hour Health Status

■ Enterprise Vault server Seven-day Health Status

■ Exchange Server Journal Mailbox Archiving Health

■ Exchange Server Journal Mailbox Archiving Trends
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Cause: These reports rely on information gathered by the Enterprise Vault
Monitoring agents. They contain no data if Enterprise Vault server Monitoring is
disabled, or if there is a problem with the Monitoring agents.

Resolution: Enable Monitoring from Enterprise Vault Operations Manager. For
instructions, see the Operations Manager online help or the Administrator’s Guide.

If server Monitoring is enabled but the reports are still not displaying data, it is
possible that there is a problem with the Monitoring agents. Follow the instructions
for troubleshooting the Monitoring agents in the following document on the Veritas
Support website:

http://www.veritas.com/docs/000033005

No information appears in reports that use auditing data
Problem: The following Operation Reports contain no data:

■ Archived Items Access

■ Archived Items Access Trends

Cause: These reports rely on information obtained from the Enterprise Vault auditing
database. They contain no data if Enterprise Vault auditing is disabled.

Resolution: Enable Enterprise Vault auditing from the Enterprise Vault
Administration Console. For instructions, see the Administrator’s Guide.

Domino Server Journal Mailbox Archiving Health report: Unable to
distinguish between Domino journal mailbox locations

Problem: If an Enterprise Vault server archives from multiple Domino servers
containing Domino journal mailbox locations with the same name, such as
symantec\*, then when viewing the Domino Server Journal Mailbox Archiving
Health report, you cannot identify the Domino server to which a journal mailbox
location belongs.

Cause: The report does not identify the Domino server to which a journal mailbox
location belongs.

Resolution: Ensure that you give unique names to the journal mailbox locations
on different Domino servers, if the locations are to be archived by a single Enterprise
Vault server.

32Troubleshooting using and exporting the reports
Troubleshooting problems with report content

http://www.veritas.com/docs/000033005


Troubleshooting report export
This section describes how to troubleshoot problems that may occur when you
export reports.

CSV format: All data appears in a single cell in Excel
Problem: Reports exported in CSV format are rendered by default in Unicode,
which results in Excel displaying all data in a single cell.

Resolution: To resolve this problem:

1 Open the following configuration file for editing on the Report Server:

<SQL_Server_Install_Path>\Reporting

Services\ReportServer\RSReportServer.config

2 Locate the following Extension tag for the CSV renderer:

<Extension Name="CSV"> </Extension>

3 Change this tag so that its content is as follows:

<Extension Name="CSV" Type="Microsoft.ReportingServices.Rendering.

CsvRenderer.CsvReport,Microsoft.ReportingServices.CsvRendering">

<Configuration><DeviceInfo><Encoding>ASCII</Encoding></DeviceInfo>

</Configuration></Extension>

Excel format: Date and timestamp does not appear
Problem: In a report exported in Excel format, the date and time details do not
appear in Excel’s Normal layout (although they are correctly shown in the footer of
printed reports).

Resolution: To view the date and time from Excel, select the File > Page Setup
> Header/Footer tab, or select File > Print Preview.

XML file format: “Page cannot be displayed” error
Problem: If you export an Asian language operating system report in XML file
format and opt to open the file rather than save it, you may receive the error Page
cannot be displayed.

Cause: This problem occurs when the report name contains double-byte character
set (DBCS) characters or special characters such as a hyphen. It occurs because
Internet Explorer applies URL encoding rules to create a temporary file name, but
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Report Manager attempts to show the exported XML file name without applying
URL encoding.

Resolution: To work around this problem, save the file before viewing it.
Alternatively, identify the location of the temporary XML file by observing the URL
displayed in the web browser when the Page cannot be displayed error is shown.
Then go to the temporary file location and open the file in Internet Explorer.

Known Issues with report export
The following are known issues relating to report export.

DBCS characters unreadable in PDF format
Double byte character set (DBCS) characters may fail to display correctly in a report
that is exported in PDF format.

Archive quota usage report: Problems when exported in
CSV or XML format
The following problems may affect the Archive quota usage report:

■ When exported in CSV format, the report may display the error:

Subreport could not be displayed.

■ When exported in XML format, the report may contain information for all users
in addition to the selected user.

This issue is related to the Microsoft Reporting Services rendering extensions,
which do not render complex reports correctly.

CSV and XML format Data Analysis reports omit table
header information
If you export a Data Analysis report in CSV format or XML format, the report’s table
column header information may be missing in the exported report.

About using Reporting with multiple Reporting
Services

Note the following if you configure Enterprise Vault Reporting on two or more
computers with different SQL Server Reporting Services.
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If both the Reporting Services are associated with the same Enterprise Vault
Directory database, then the permissions associated with Enterprise Vault's
administration roles apply to both of the Reporting Services. That is, a user account
whose role permits access to some reports in one Reporting Services can also
access the same reports in the other Reporting Services. However, a user's actions
in one Reporting Services are not reflected in the other. This can result in the
following scenario:

■ A user account that is assigned the FSA Administrator role accesses the Report
Server web application for Reporting Services A. The user subscribes to a
number of FSA reports and creates a database snapshot.

■ The same user account later accesses the Report Server web application for
Reporting Services B. The user then checks for subscribed reports and
snapshots, but finds no record of the subscriptions or the snapshot that relate
to Reporting Services A.

To work around this issue, the user must perform the required actions in both of
the Reporting Services.
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